
Measure, evaluate, and troubleshoot
cdma2000 and 1xEV-DV compatible

signals with the 89601A vector signal
analysis software (v5.20) and its 

3G modulation analysis Option B7N.
This software works with a variety

of measurement hardware including
Agilent spectrum analyzers,

Infiniium scopes, and the 
89600 VXI systems.
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• integrate analysis with the Agilent 
EEsof Advanced Design System 
(ADS) 
• analyze design simulations
• analyze product/component 

performance
• produce data for further 

analysis/reporting

Advanced cdma2000/1xEV-DV 
analysis tools
Option B7N adds cdma2000 and
1xEV-DV demodulation capabilities
to the 89601A VSA software. This
option measures 3GPP2 Technical
Specification Group cdma2000 
specifications (C.S0002-C physical
layer standard release C version 1.0,
and C.S0003-C MAC standard release
C) compliant signals and supports
3GPP2, release C, 1xEV-DV signal
measurement capabilities.

These capabilities descramble,
despread, and demodulate forward
link and reverse link cdma2000,
spread rate one (SR1) signals. The
1xEV-DV analysis is for forward link
signals. The software automatically
identifies all active channels, 
regardless of the symbol rate or
Walsh code length.

Signal analysis capabilities include
composite code domain power, 
composite time, and channel specific
analysis. Measurement results may
be shown in several trace display 
formats as well as numeric error
data formats. Flexible display scaling
and marker functionality enhance
these measurement capabilities.

The software-based demodulator
used in this analyzer incorporates
advanced technology that does not
require coherent carrier signals or
symbol-clock timing signals. The 
software has a built-in IS-2000 filter.
Signal locking requires only the 
carrier frequency, chip rate,
reverse/forward link direction, 
and long code mask to be set. The
demodulator uses the measured 
signal, called I/Q Meas Time, to 
generate an ideal signal, called IQ
Ref Time. The software uses these
signals to provide comparison data,
modulation quality data results and
error summary data.  

Measurement result data includes:
time and frequency domain trace
data, code domain power data 
(composite or layer specific), code
domain error data (composite or
layer specific), channel data results,
and overall error summary results.

If you have measurement hardware
with two baseband channels, the
89601 VSA software provides IQ
baseband measurement capability.
You can also perform IQ baseband
measurements on data from a file 
or the stream interface, i.e. ADS 
simulation.

The 89601 Vector Signal Analysis
(VSA) software is one of the most
advanced signal analysis packages 
on the market today. It combines a
robust set of analysis tools with
unusual flexibility for applying and
teaming these tools. Use this 
robustness and flexibility to
• test your signal to its standard
• troubleshoot problems when your 

signal fails to meet its standard

Use the 89601A software to
• analyze signals up to 6.0 GHz 

bandwidth (requires Infiniium 
scope)

• record signals and play them back 
to extend analysis capabilities

• demodulate standards-based 
signals ranging from NADC to 
cdma2000 to 802.11g WLAN

• demodulate signals based on less 
common or even proprietary 
standards

• troubleshoot digitally modulated 
signal problems, isolate symbol 
clock errors, identify filtering 
problems, and more

• use analog demodulation to
• demodulate and analyze AM, FM, 

and PM modulated signals
• analyze settling problems in 

oscillators and PLLs
• locate unintentional modulation

• work in multiple domains and 
formats

• access a full set of markers to find 
peaks, measure frequency, phase, 
amplitude, offsets, simplify 
power measurements, perform 
gated measurements, and more

• work with a wide selection of 
measurement hardware
• high dynamic range VXI bundles
• spectrum analyzers offering high

dynamic range and up to the 
50 GHz frequency range

• scopes with up to 6 GHz analysis
bandwidth

Robust Analysis Tools and Unusual Flexibility
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cdma2000/1XEV-DV Modulation Analysis Features

These features are applicable for
both cdma2000 and 1xEV-DV 
modulation analysis
• standard presets for

• cdma2000 reverse link
• cdma2000 forward link

• variable, user-definable chip rate 
(1.2288 MHz standard pre-set)

• single layer or composite 
code-domain power and code-
domain error traces (the 
composite display shows all 
code layers simultaneously); 
normalize code-domain power to 
display the CDP relative to the 
total signal power

• composite and single channel 
time-domain displays such as 
constellation, trellis and eye 
diagrams, IQ magnitude/phase 
error, and error vector traces

• mirrored (flipped) frequency 
spectrums used to remove the 
effects of high-side mixing or 
complex conjugation mismatches 
in simulated data

• measurement offset and interval 
(similar to time gating) used to 
select specific data slots for 
analysis

• averaging for code domain data 
and numeric error data in the 
Error Summary table, as follows
• RMS (video): computes an 

average of each RMS error 
update in the table

• RMS exponential: like RMS 
(video) except that averaging 
continues past the average 
count with an exponential 
weighting

• continuous peak hold: keeps 
track of the peak RMS error 
of each update in the table

These features are applicable to
1xEV-DV modulation analysis only
• automatic modulation scheme 

detection for F-PDCH channels
• manual control of all F-PDCH 

properties
• automatic active channel 

identification 
• optional predefined F-PDCH active

channel configuration for adaptive 
modulated signals

• optional gated active channel 
identification for adaptive
modulated signals

• optional gated modulation detection
for adaptive modulated signals
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Demonstration Preparation

This demonstration uses the 89601A
VSA software and a PC meeting the
requirements shown. No measurement
hardware is required because the
demonstration uses a pre-recorded
signal recalled from a file.

Table 1a. Demonstration PC and software requirements.

PC requirement Desktop Laptop

CPU 180 MHz Pentium® or AMD-K6 > 300 MHz Pentium or AMD-K6
(> 300 MHz recommended)

Empty slots (required only if 1 PCI-bus slot 1 CardBus type II slot 
using measurement hardware) (two recommended) (two recommended)

RAM 192 MB (256 MB recommended 192 MB (256 MB recommended

Video RAM 4 MB (8 MB recommended) 4 MB (8 MB recommended)

Hard disk space 200 MB available 200 MB available

Operating system Microsoft® Windows 2000® Microsoft Windows 2000 
or XP Professional® or XP Professional

Additional drive CDROM or 3.5 inch floppy CDROM or 3.5 inch floppy
(if no network access available) (if no network access available)

Interface support IEEE 1394-19951 (FireWire), IEEE 1394-19951 (FireWire),
(required only if using LAN, or GPIB LAN, or GPIB
measurement hardware)

Table 1b. Demonstration PC and software requirements.

Software requirements

Version v5.20 or higher

Option - 200: Basic vector signal analysis

- 300: Hardware connectivity 
(required only if measurement hardware will be used)

- B7N: 3G modulation analysis
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Setup Procedure

This procedure is intended to help
users get started using the 89601A
VSA software to evaluate cdma2000/
1xEV-DV signals. Detailed information
and explanations of the signal and
the operation of the software are
available in the 89601 on-line Help
located on the toolbar.

Recall the cdma2000/1xEV-DV 
example signal
The 89601A VSA software includes a
pre-recorded cdma2000/1xEV-DV 
signal. Recall this recording as 
shown in Table 2.

Setup the RF measurement parameters
Set the RF parameters as shown in
Table 3 to measure the pre-recorded
cdma2000/1xEV-DV signal.

Connecting the signal to the analyzer
No hardware is required to analyze
the recorded signal used in this 
procedure.  

The 89601A software can analyze 
RF and baseband (I/Q) signals. Refer 
to the 89601A on-line Help 1xEV-DV 
or cdma2000 for information on
hardware set-up. Refer to the 
Ordering Information at the end of 
this document for information on
measurement hardware.

Center frequency
In general, to assure a successful 
carrier lock, set the center frequency
within approximately ±500 Hz of the
carrier frequency of the signal.

Frequency span
When preparing to demodulate a 
signal, it is usually best to select a
span that is slightly larger than the
bandwidth of your signal. If you
select a span that is too narrow, your
measurement may have excessive
errors or the software may lose 
carrier lock. For best results for
cdma2000/1xEV-DV signals, the 
frequency span should be set 
according to the following formula 

Frequency span ≥ (1.204 x chip rate)

Figure 1.

Table 2. Signal recall instructions.

Instructions Toolbar menus

Go to the signals directory File > Recall > Recall Recording

Select the recording 1xEVDV.sdf > Open

Start measurement Click on (toolbar, left side)

Table 3. RF measurement parameters setup instructions.

Instructions Toolbar menus

Set center frequency MeasSetup > Frequency > Center
Enter 1.85625 GHz

Set frequency span MeasSetup > Frequency > Span
Enter 1.5 MHz

Set input range Input > Range > Range
Enter –20 dBm

Auto scale trace A Place cursor in trace A,
right click the mouse > Y Auto Scale

Input range
The input range must be set correctly
to obtain accurate measurements.
Input ranges that are too low overload
the hardware front-end. Input ranges
that are too high increase noise,
which increases errors reported in
error data results, such as error 
vector magnitude (EVM.)

Setting the input range is not
required on this pre-recorded signal.
The example sets the input range
only to illustrate how to use the
input range control.

Y Auto Scale
Clicking Y Auto Scale rescales and
repositions the active trace to ensure
that all points fall within the bounds
of the trace display on the Y-axis.
Unlike spectrum analyzers, the 
Y-axis scale is not tied directly to 
the input range. Changing the 
Y-axis scale does not change the
input range attenuation of the 
measurement hardware.  
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Setup the demodulator
Select the cdma2000/1xEV-DV
demodulator as shown in Table 4.

You should always view the signal
spectrum first to be sure that the 
signal is present and that the 
center frequency, span, and input
range are correct before selecting 
a demodulator.

After selecting the demodulator 
you need to set its configuration
parameters. The software will 
automatically configure the 
demodulator if you select one 
of the available Preset to Default
choices, or you can manually 
configure the demodulator from 
the Demod Properties menu.

The parameters set by the Preset to
Default selections, and the values
they are set to, are shown below. 
See the 89601A on-line Help for 
more information on these controls

Forward/Reverse link direction 
Forward
Chip rate 1.2288 MHz
Symbol rate 64
Spread-code-length 
(Symbol Rate) 64 

(19.2 ksym/s)
Result length 16 PCG
Mirrored spectrum No
Base code 
(forward link only) 64

Long code mask (reverse link only)
Defined channel (not required)

Table 4. Instructions to setup the demodulator.

Instructions Toolbar menus

Select the demodulator MeasSetup > Demodulator >
3G Cellular > cdma2000/1xEV-DV

Preset all demodulator MeasSetup > Demod Properties > 
parameters to forward link Format (tab) > Preset to Default...> Forward

Enable 1xEV-DV analysis MeasSetup > Demod Properties > Format 
(tab) > Enable 1xEV-DV analysis

Add four traces to the display Display > Layout > Grid 3x2

Start the measurement Click on

Figure 2.

�
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A composite measurement is a 
measurement made on all code 
channels at once. These measurements
include: composite code domain
power (CDP), composite code domain
error (CDE), as well as time domain
measurements such as rho, EVM,
EVM spectrum, and EVM time. 
These measurements are useful 
for evaluating the overall in-band
performance of the cdma2000/
1xEV-DV signal. 

Composite vector diagram and error
summary table
The steps shown in Table 5 set up
the composite constellation and 
composite error summary table.
(These steps are provided to show
how to set a constellation trace 
and an error table. The same 
information is already available 
in traces C and D of the previous
step.)

Trace A: Composite measurement
time (constellation display)
This constellation is quite noisy but
is characteristic of the composite
cdma2000/1xEV-DV signal. Seeing
this shape provides a first order 
indication that the demodulator is
properly setup.

Trace B: Composite error summary
The composite error summary 
display shows you the following
measurement results for the 
composite signal:

Composite Measurements

Figure 3.

Table 5. Instructions for composite constellation and composite error summary table setup.

Instructions Toolbar menus

Set the display to a Display > Layout > Stacked 2
stack of two traces

Change trace A to show Double click on trace A’s title
composite IQ time (constellation) (upper left corner of trace) > 

Channel 11 Comp > IQ Meas Time

Auto-scale trace A Right click on trace A > Y Auto Scale

Change trace B to show the Double click on trace B’s title 
composite error summary table (upper left corner of trace) > 

Channel11 Comp > Error Summary

Composite EVM (EVM) is the error
vector magnitude for the composite
signal, including all Walsh code
lengths and Walsh code numbers.
The table shows RMS percentage
EVM, the peak (largest) percentage
EVM, and the chip number with 
the peak percentage EVM. This
parameter is computed at the 
chip rate. 

Composite magnitude error (Mag
Err) is the difference in amplitude
between the I/Q measured signal 
and the I/Q reference signal for the
composite signal.

The display shows these magnitude
error values: the RMS percentage
magnitude error, the peak 
percentage magnitude error, and 
the chip number with the peak 
percentage magnitude error.

1. Channel 1 refers to the measurement channel, not 
to any channel contained in the signal
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Composite phase error (Phase Err)
is the difference, in phase, between
the I/Q reference signal and the I/Q
measured signal for composite signal,
including all Walsh code lengths and
Walsh code numbers.

The display shows these phase error
values (in degrees): the RMS phase
error, the peak phase error, and the
chip number with the peak phase
error.

Composite IQ offset (also called I/Q
origin offset) indicates the magnitude
of the carrier feed-through signal.
When there is no carrier feed-
through, IQ offset is zero (infinity
dB). Refer to EVM spectrum in this
section for a second measure of 
carrier leakage.

Composite frequency error (Freq
Err) shows the composite signal 
carrier frequency error relative to
the analyzer’s center frequency. 
This parameter is displayed in Hertz
and is the amount of frequency shift,
from the analyzer’s center frequency,
that the analyzer must perform to
achieve carrier lock.

Composite rho is the normalized 
correlation coefficient between the
measured and ideal reference signals,
and is designated as the waveform
quality factor. The maximum value 
of rho is 1.0, which means the 
measured signal and reference 
signal are identical.

Composite PCG identifies the PCG
used for the composite measurement
(except composite CDP). The composite
PCG ignores the measurement offset,
which is different from the channel
PCG (see following section), which 
uses the measurement offset. The
composite PCG number is available
only when the measurement is 
triggered. 

For an accurate PCG number, 
the trigger should be a signal like 
an “even second” signal that is 
synchronized to the start of the
cdma2000 frame.

Composite T trigger shows the
amount of time, in chips, from the
trigger to the start of the sync 
symbol. For example, the sync 
symbol marks the beginning of a
frame of 16 PCGs. If you select a 
trigger that starts the measurement
at the beginning of a PCG, the 
T trigger value would be 0 chips. 
The T trigger value is displayed 
only for triggered measurements.

Composite peak active CDE is the
largest active code channel code
domain error (in dB). This is the
largest measured CDE for all active
code channels in the composite 
signal.

Composite peak CDE is the largest
measured code channel code domain
error. This is the largest measured
CDE for all code channels (active 
and inactive) in the base code layer
(the code layer with the smallest
symbol rate) in the composite signal.

If averaging is on, averaging is
applied to most of the numeric 
error data in the error summary 
data except for peak EVM, peak 
magnitude, and peak phase error.
These values are averaged only 
for the continuous peak hold 
averaging type.
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Composite CDP and CDE
Composite code domain power (CDP)
and composite code domain error
(CDE) measure the power and 
error of the signal by code channel.
They provide more detail on signal
behavior and modulation quality
than the composite EVM or rho.

The steps shown in Table 6 will 
take you through setting up these
measures.

Trace A: Composite CDP
The CDP trace shows the measured
power in each code channel in the
composite signal. This trace is 
an analysis of the distribution of 
signal power across the set of code 
channels normalized to the total 
signal power.  

The data is shown in a multi-color
form that assigns a unique color to
each code layer and related active
code channels. In this example the
active channels are orange (standard
cdma2000) and blue (1xEV-DV 
packet data channels). The inactive
channels have no fill color.  

Trace B: Composite CDE
The composite CDE trace shows 
the CDE values for each active code
channel (Walsh code number) for 
all code layers (Walsh code lengths).
It also shows the CDE value for 
each inactive code channel at the
lowest code layer. The CDE of a 
particular code channel is a measure
of the error power in a code channel
relative to the total signal power. 

The data is shown in a multi-color
form that assigns a unique color to
each code layer and related active
code channels. In this example the
active channels are orange (standard
cdma2000), and blue (1xEV-DV 
data packet channels). The inactive
channels have no fill color. 

Figure 4.

Table 6. Composite CDP and CDE setup instructions.

Instructions Toolbar menus

Add two more grids to the display Display > Layout > Grid 2x2
so CDP and CDE can be shown

Change trace A to show Double click on Trace A’s title >
composite CDP Channel 11 CDP > CDP composite

Auto-scale trace A Right click on trace A > Y Auto Scale

Change trace B to show Double click on Trace B’s title >
composite CDE Channel 11 CDP > CDE composite

Auto-scale trace B Right click on trace B > Y Auto Scale

1. Channel 1 refers to the measurement channel, not 
to any channel contained in the signal
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Markers 
The 89601 VSA software includes
several markers and marker functions
accessible from the Markers menu.
Each trace has its own set of 
markers. You can quickly set marker
locations, manually re-position them,
locate peak values, and couple the
markers between traces to show 
common values. Marker calculation
features allow you to easily calculate
band power, RMS band power, and
channel-to-noise power.

Markers can also help users 
understand the information presented
in a trace. For cdma2000/1xEV-DV
modulation, the CDP and CDE 
displays related code channels
(Walsh code number) are dispersed
along the X-axis as defined by the
Hadamard code order. This makes
visually identifying related code
channels difficult. The Trace A 
marker solves this problem by 
pointing to the related parts, in this
case a 1xEV-DV packet data channel.  

Trace A: Composite CDP,
Hadamard order, with markers
The marker shows the following 
values (bottom of screen):

Symbol rate 38.4 Ksym/s
Walsh code length 32
Walsh code number 14
Power level –25.143 dB
Asterisk * The asterisk 

indicates the 
marker is 
positioned 
on an active 
channel

Trace B: Composite CDE, bit
reverse order
Another way to look at the composite
code domain channels is to reorder
them so related code channels are 
displayed adjacent to each other. 
The bit-reversed generation of 
Walsh channels provides us with 
this code ordering.

In trace B the channels are shown 
in bit reverse order. 

Figure 5.

Table 7. Marker setup.

Instructions Toolbar menus

Enable the trace A marker Click on trace A > Markers > Tool > Marker
OR
Right click on trace A > Show Marker

Enable the trace B marker Right click on trace B > Show Marker

Change the code order in Click on trace B > Trace > Digital Demod >
trace B to bit reverse Code Order (drop down menu) > Bit Reverse > Close
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EVM time and EVM spectrum 
Two useful displays for evaluating
the behavior of the composite signal
are error vector time and error 
vector spectrum.  

The steps shown in Table 8 will 
take you through setting up these
measures.

Trace A: EVM time
EVM time shows EVM behavior over
time, where chips represent time.
You can view error vector time data
as EVM, error vector phase, the 
I component, or the Q component
only. This feature is used to find
impulsive errors such as a transient
overload event or a clock circuit 
giving off spikes. It is also useful 
for finding low frequency errors
caused by close-in phase noise. 
Trace A is typical of a signal 
without any of these problems. 
It is relatively flat and consistent
across all 1.527 kchips.

Trace B: EVM spectrum
EVM spectrum is the FFT of the EVM
time trace and shows the frequency
content of the EVM. Trace B shows 
a high error signal at 1.856 GHz 
(see Trace B marker value at bottom
of display.) This is the carrier 
frequency of the pre-recorded signal
and represents carrier feed through.
Any spurious signal will show up 
as a discrete peak in the composite
error vector spectrum trace.

The analyzer’s demodulator removes
carrier-frequency error. Therefore, in
the composite error vector spectrum
display, you must add the carrier-
frequency error to marker readouts
to obtain exact frequency information.
The carrier-frequency error (Freq
Err) is shown in the Composite 
Error Summary Table.

Figure 6.

Table 8. EVM time and EVM spectrum setup.

Instructions Toolbar menus

Setup a display with only two Display > Layout > Stacked 2
vertically stacked traces

Set the top trace to display Double click on trace A’s title
error vector time > Channel 1 Comp > Error Vector Time

Set the bottom trace to display Double click on trace B’s title
error vector spectrum > Channel 1 Comp > Error Vector Spectrum

Enable a marker in the bottom trace Click on trace B > Markers > Tool > Marker
OR
Right click on trace B > Show Marker

Put the marker on the peak near Right click on trace B > Peak
the center of the trace

Start the measurement Click on �
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Measuring a single channel
The instructions in Table 9 show 
how to use markers and the 
Copy Marker to Despread Chan
function to quickly view a single
channel in your cdma2000/1xEV-DV
signal. You can also go directly to 
the desired channel by entering its
parameters in the Demod Properties
menu.

Copy marker to Despread Chan
sets the Walsh code length and Walsh
code number parameters in the
Demod Properties > Channel/Layer
menu. 

Walsh code length and Walsh code
number specify the channel used for
channel trace displays. These traces
include Chan Syms/Errs (which 
displays the symbol table for the
selected channel), Chan Mag Error,
Chan Phase Error, Chan Error
Vector, and Chan IQ Meas Time.

Trace A: Channel 1 composite CDE
See the previous section.

Trace B: Channel 1 chan error 
vector time
This trace shows how the error 
vector changes with time (where
symbols represent time) for the 
specified code channel (Walsh code
number) and code layer (Walsh code
length). The ideal error vector time
trace is a flat horizontal line at 
zero percent.  

Channel Measurements

The error vector time trace is made
up of complex, time-domain data.
Each point in the trace has two 
components: I and Q. To make 
sense of the data you must select 
an appropriate trace data format
(Trace > Format > Format: 
drop-down list).  
Linear mag Shows the EVM
Real (I) Shows the I 

component of the 
error vector

Imag (Q) Shows the 
Q component of 
the error vector

Wrap phase Shows error vector 
phase

Trace C: IQ measured time   
This trace is the demodulated data
sampled at the chip times for the
specified code channel (Walsh code
number) and code layer (Walsh 
code length). This data can also 
be displayed in Q-eye, I-eye, and 
trellis-eye formats (double click on
the Y-axis label).

If normalization is off, the analyzer
shows the instantaneous magnitude.
If normalization is on, the analyzer
scales the IQ measured and IQ 
reference traces to map them onto
the unit circle, which yields a 
unitless y-axis.

Trace D: Ch1 Syms/Errs
This display shows the error 
summary data for the specified
Walsh code number and Walsh 
code length. Unlike the Composite
Symbols/Errors table this table
shows the demodulated bits.

If averaging is on, averaging is
applied to most numeric error data
in the error summary data with the
following exceptions. The peak data
values, such as peak EVM, peak 
magnitude, and peak phase error 
are averaged only for the continuous
peak hold averaging type.
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Figure 7.

Table 9. Instructions for making channel measurements

Instructions Toolbar menus

Setup a 2x2 display grid Display > Layout > Grid 2x2

Set trace A to display composite Double click on the trace A’s title
code domain error > Channel 1 CDP > CDE composite

Auto-scale trace A’s vertical scale Right click on trace A > Y Auto Scale
to get better resolution 

Send the marker to the channel Right click on trace A > Peak
with the highest CDE

Select the marked channel for Right-click on trace A > Copy Marker to Despread Chan
more detailed analysis

Change Trace C to display the vector Double click trace C’s title 
diagram for the selected channel > Channel 1 Chan > IQ Meas Time

Change Trace D to display the symbol Double click on trace D’s title
table for the selected channel > Channel 1 Chan > Syms/Errs

Change Trace B to display Double click on trace B’s title
the error vector time trace for > Channel 1 Chan > Error Vector Time
the selected channel

Auto-scale trace B Right click on trace B > Y Auto Scale

Send the B marker to the channel Right click on trace B > Peak
with the highest EVM
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Code layer and code channel 
CDP and CDE
The instructions in Table 10 show
how to measure code domain power
and code domain error for a specific
spread code length or layer.

Trace A: 38.4 ksym/s CDP 
This trace shows the measured 
channel power for all code channels
(Walsh code number) within the
specified code layer (Walsh code
length.) If the measurement interval
is greater than one, all slots within
the measurement interval are 
averaged together to produce 
the CDP Layer results.

Trace B: 38.4 ksym/s CDE
This trace shows the channel power
error values for each code channel
(Walsh code number) within the
specified code layer (Walsh code
length.) The CDE of a particular 
code channel is a measure of the
error power in a code channel 
relative to the total signal power.
CDE Layer trace data results are
computed only from the first 
measured slot. This is different 
than CDP Layer trace data results,
which can include more than the
first slot in the measurement results.

Figure 8.

Table 10. Channel code domain power and error measurement configuration instructions.

Instructions Toolbar menus

Select trace A and setup a Click on trace A
display with only two vertically Display > Layout > Stacked 2
stacked traces

Set the demodulator to measure MeasSetup > Demod Properties...
the CDP for Walsh code length 32 > Channel/Layer (tab) > Walsh code length 

> 32 (38.4 ksym/s) (drop down menu) > Close

Set trace A to display the Double click on the trace A’s label 
CDP for the layer > Channel 1 CDP > CDP layer > OK

Auto-scale trace A Right click trace A > Y Auto Scale

Set trace B to display the CDE Double click on the trace B’s label 
for the layer > Channel 1 CDP > CDE layer > OK

Auto scale trace B Right click trace B > Y Auto Scale
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F-PDCH in demod properties menu
Use the Defined Active Channel
feature in the Demod Properties
menu when the 89601 VSA’s 
auto-detection algorithm is not 
properly identifying the F-PDCH
active channels or modulation 
formats. Defined Active Channels
forces the analyzer to override 
the auto-detection algorithm and 
to recognize all F-PDCH channels
specified by the Define F-PDCH
parameters. 

This feature is particularly useful 
in early design when errors may be
too great to allow the auto-detection
algorithm to successfully identify 
all active channels. 

To define the measurement channels,
you must specify the Walsh-code
assignments and modulation formats
for both the F-PDCH0 and F-PDCH1
channels. The defined F-PDCH 
channels are always presumed active
regardless of the actual input signal.
The total number of identified active
channels includes those specified 
by the Defined Channels and any
additional active channels detected
by the active channel algorithm.  

Figure 9.
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Making adaptive modulation and 
coding (AMC) measurements
1xEV-DV supports adaptive 
modulation and coding (AMC) in 
the F-PDCH channel. 

In the AMC system, the modulation
scheme of each packet data channel
may be dynamically changed 
between QPSK, 8PSK, or 16QAM
every sub-packet length. The F-PDCH 
sub-packet length can be transmitted
using one, two, or four slot durations.

The analyzer does not directly 
support AMC signal measurements;
however, AMC measurements can 
be accomplished on a slot-by-slot
basis. If a code channel changes 
modulation format or active status,
you can obtain correct measurement
results by limiting the measurement
to intervals that have a constant
modulation scheme. 

To properly measure a 1xEV-DV 
signal with AMC on the F-PDCH
channel (Walsh code length 32), 
follow these setup instructions.

a. Select the Use gated modulation
detection and Use gated active
channel detection modes from the
Time properties tab [MeasSetup >
Demod Properties > Time tab]. 
This makes sure that only 
those slots within the specified 
measurement interval are included
in the measurement data. 

b. Carefully specify the appropriate
measurement interval using 
the Measurement Interval and
Measurement Offset parameters. 
It is important that you select 
measurement intervals that contain
only one modulation type and have 
a total number of slots equivalent 
to an integral number of F-PDCH
sub-packet lengths.

Figure 10.
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Figure 12.

Figure 11.c. Carefully specify the appropriate
measurement interval using the
Measurement Interval and
Measurement Offset parameters. 
It is important that you select 
measurement intervals that contain
only one modulation type and have 
a total number of slots equivalent 
to an integral number of F-PDCH
sub-packet lengths.

d. If a despread channel measurement
of an F-PDCH channel does not 
automatically detect the correct 
modulation scheme, you can 
override it by selecting the Manual
Modulation Scheme mode and 
specifying the desired modulation
format [MeasSetup > Demod
Properties > Channel/Layer tab].

e. If the analyzer is not correctly
auto-detecting the active channels,
possibly due to extreme power
changes (burst on/off), override 
the threshold level by using the
Active Channel Threshold
parameter on the Advanced tab
[MeasSetup > Demod Properties >
Advanced tab].
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Additional Measurements

Channel power
The 89601 VSA band power 
measurement determines the total
power in a user-specified bandwidth.
This measurement is used to make
standards-based channel power
measurements by setting the 
bandwidth and center frequency 
of the band power marker to the 
values called out in the standard.

The following band power 
measurement parameters are 
user-controlled

• center frequency
• bandwidth
• number of averages 

(in MeasSetup > Average menu)
• power calculation

band power (dB)
RMS square root power (Vrms) 
C/N - carrier to noise power (dB)
C/No - carrier to noise density 
(dB/Hz)

Figure 13.

Table 11. Setup for measuring channel power.

Instructions Toolbar menus

Pre-set the set up for the File > Preset > Preset Setup
89601 software

Recall the 1xEV-DV signal File > Recall > Recall Recording > 1xEV-DV.sdf > Open

Start the measurement Click on (toolbar, left side)

Auto-scale trace A Double click on trace A > Y Auto Scale

Activate the band power marker Right click trace A > Show Band Power
in the spectrum trace

Set the center frequency and span Markers > Calculation > Center, Width
for the band power marker Center: 1.85625 GHz

Width: 1.2288 MHz 

Select the power calculation Markers > Calculation > Calculate > Band Power

Activate a marker and put it Right click on trace > Show Marker
at the center frequency 
(Optional, shows frequency and Markers > Position > X Position
power at center of span) Enter: 1.85625 GHz
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Power statistics (CCDF)
The complementary cumulative 
distribution function (CCDF) 
characterizes the power statistics 
of a signal by plotting the peak-to-
average power ratio (PAR) versus
probability of occurrence. This 
is a key measurement for power
amplifiers designed for cdma2000/
1xEV-DV base stations as these
devices must be capable of handling
the PAR of the digitally modulated
signals while maintaining good 
adjacent channel leakage 
performance. 

In the example shown the average
power of the signal is –20.65 dBm
(top center of grid B) and only 0.091
percent of all signal peaks measured
were more than 7.52 dB above the
signal’s average power.

Figure 14.

Table 12. Set up for measuring CCDF.

Instructions Toolbar menus

This measurement is made on the time trace of the signal. 
Refer to Setup the RF measurement parameters in the Setup Procedures section. 
The digital demodulators must be off for this measurement to work. 
(MeasSetup > Demodulator > Demod Off)

Change the “Main time” Double click on the trace title
trace to CCDF (upper left corner of grid) > Channel 1 > CCDF

Start the measurement Click on 

Activate a marker on the CCDF trace Right click on the trace > Show Marker

Find the PAR needed to assure Drag the marker along the CCDF plot until the marker  
the signal will be clipped readout at the bottom of the display shows <100 m%
< 0.1% of the time 

If the bottom of the CCDF graph is jagged (looks like stair steps) keep running the measurement. 
CCDF is a statistical measurement and gives best results with large sample sizes. 
The sample size is shown as “Pts” parameter at the top of the CCDF trace.
The “Avg” parameter shows average measured signal power.

�
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Key Menu Reference

Demod properties menu
Access these menus via the toolbar
by clicking MeasSetup > Demod
Properties (the cdma2000/1xEV-DV
demodulator must be selected). For
more information on the functions
controlled by the menu click the 
Help button in the lower right 
corner of the menu.

Figure 15.
Demod Properties 
menu > Format tab

Figure 16.
Demod Properties 
menu > Channel/
Layer tab

Figure 17.
Demod Properties 
menu > Time tab
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Figure 18.
Demod Properties 
menu > Defined 
Channels tab

Figure 19.
Demod Properties 
menu > Advanced tab
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Trace data menus
Access this menu by clicking Trace >
Data > Ch1 Chan in the toolbar or 
by double clicking on the trace title
annotation at the upper left corner 
of the trace you wish to change.

For more information on the 
functions controlled by the menu,
click the Help button in the lower
right corner of the menu.

Figure 21.
Trace data menu > 
Type: Channel 1 > 
Data (display) 
menu selections

Figure 22.
Trace data > Type: 
Channel 1 CDP > 
Data (display) 
menu selections

Figure 23.
Trace data > Type: 
Channel 1 Chan > 
Data (display) 
menu selections

Figure 24.
Trace data > Type: 
Channel 1 Comp > 
Data (display) 
menu selections

Figure 20.
Trace >Data
> Ch1 Chan

Trace title



1. 89601A/AN software included

2. Software can be run on Infiniium internal PC
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89601A Vector Signal Analysis
software
89601A VSA software, node-locked license
89601AN VSA software, floating license
Opt 200 Basic analysis software
Opt 300 Hardware connectivity
Opt AYA Flexible vector modulation analysis
Opt B7N 3GPP modulation analysis
Opt B7R WLAN modulation analysis
Opt 105 Advanced design system streaming 

interface

Measurement hardware
Vector signal analyzer bundled
systems1

(Two baseband channels and/or two 
RF channels available)

Models Frequency range Max. analysis
bandwidth

89610S DC to 40 MHz 40 MHz
89611S 52 to 88 MHz 36 MHz
89640S DC to 2.7 GHz 36 MHz
89641S DC to 6.0 GHz 36 MHz

PSA Series spectrum analyzers
Models Frequency range Max. analysis

bandwidth

E4440A 3 Hz to 26.5 GHz 8 MHz
E4443A 3 Hz to 6.7 GHz 8 MHz
E4445A 3 Hz to 13.2 GHz 8 MHz
E4446A 3 Hz to 44 GHz 8 MHz
E4448A 3 Hz to 50 GHz 8 MHz

ESA-E Series spectrum analyzers
Models Frequency range Max. analysis

bandwidth

E4401B 9 kHz to 1.5 GHz 10 MHz
E4402B 9 kHz to 3.0 GHz 10 MHz
E4404B 9 kHz to 6.7 GHz 10 MHz
E4405B 9 kHz to 13.7 GHz 10 MHz
E4407B 9 kHz to 26.5 GHz 10 MHz

Infiniium oscilloscopes
Models Frequency range Max analysis 

bandwidth

54830B/D DC to 780 MHz 780 MHz
54831B/D DC to 780 MHz 780 MHz
54832B/D DC to 1.0 GHz 1 GHz
54853B2 DC to 2.5 GHz 2.5 GHz
54854B2 DC to 4.0 GHz 4 GHz
54855B2 DC to 6.0 GHz 6 GHz

Sources
ESG Series digital RF signal generators
E4431B 250 kHz to 2 GHz
E4432B 250 kHz to 3 GHz
E4433B 250 kHz to 4 GHz
E4434B 250 kHz to 1 GHz
E4435B 250 kHz to 2 GHz
E4436B 250 kHz to 3 GHz
E4437B 250 kHz to 4 GHz
E4438C 250 kHz to 1/2/3/4/6 GHz

PSG Series microwave signal generators
E8267 250 kHz to 20 GHz

Software
Advanced Design System (ADS) software 
Advanced RF/µW design and simulation software.

Ordering Information

The 89601A VSA software works 
with a variety of measurement 
hardware, sourcing hardware, and
other software. 

In general an external PC with a
LAN, FireWire, or GPIB interface 
is required to run the software and
control the hardware.
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Agilent Technologies’ Test and Measurement
Support, Services, and Assistance
Agilent Technologies aims to maximize the value you
receive, while minimizing your risk and problems. 
We strive to ensure that you get the test and 
measurement capabilities you paid for and obtain
the support you need. Our extensive support
resources and services can help you choose the
right Agilent products for your applications and
apply them successfully. Every instrument and 
system we sell has a global warranty. Support is
available for at least five years beyond the production
life of the product. Two concepts underlie Agilent’s
overall support policy: “Our Promise” and “Your
Advantage.”

Our Promise
Our Promise means your Agilent test and 
measurement equipment will meet its advertised
performance and functionality. When you are choosing
new equipment, we will help you with product
information, including realistic performance 
specifications and practical recommendations 
from experienced test engineers. When you use
Agilent equipment, we can verify that  it works
properly, help with product operation, and provide
basic  measurement assistance for the use of
specified capabilities, at no extra cost upon request.
Many self-help tools are available.

Your Advantage
Your Advantage means that Agilent offers a wide
range of additional expert test and measurement
services, which you can purchase according to 
your unique technical and business needs. Solve
problems efficiently and gain a competitive edge 
by contracting with us for calibration, extra-cost
upgrades, out-of-warranty repairs, and on-site 
education and training, as well as design, system
integration, project management, and other 
professional engineering services. Experienced
Agilent engineers and technicians worldwide can
help you maximize your productivity, optimize the
return on investment of your Agilent instruments and
systems, and obtain dependable measurement
accuracy for the life of those products.  

www.agilent.com/find/emailupdates

Get the latest information on the products and 
applications you select.

Agilent T&M Software and Connectivity
Agilent’s Test and Measurement software and 
connectivity products, solutions and developer 
network allows you to take time out of connecting
your instruments to your computer with tools 
based on PC standards, so you can focus on 
your tasks, not on your connections. Visit 
www.agilent.com/find/connectivity
for more information.

Pentium is a U.S. registered trademark 
of Intel Corporation. Microsoft, Windows 2000, 
NT, and XP Professional are U.S. registered 
trademarks of Microsoft Corporation.


